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1. Introduction 

This sub-assembly is a high-power engraving laser head with thermal protection and a professional high-speed 

driver. Its design ensures that the head doesn’t require any additional cooling. The fan and airflow design make 

it perform as a fully customized air nozzle protecting lens from dirt and cooling the laser head. This sub-

assembly takes advantage of a PLHD 3D 6W driver which ensures proper function of the laser head while 

protecting the laser diode from overheating. 

 

There is an automatic thermal cutoff where at 45°C the laser head switches off. A turn to adjust collimating lens 

allows you to easily change the beam focus distance. Air flow from the fan is designed to keep the lens clean 

during operation. You can use two type of lens with our PLH3D laser heads. G2 lenses are popular because of 

the efficiency but efficiency is not necessarily the most important parameter. While laser engraving, power 

density is more important – unfortunately G2 lenses do not provide as small beam spot (while focused) as 

most three element lenses. The three-element lens though it causes a bigger optical power loss, allows you to 

obtain a smaller beam spot. This helps to obtain a higher power density to area ratio, while also giving the 

added benefit of a thinner cutting path. 

 

The choice is up to customer’s requirements, since in some situation it is better to use G2 lens and sometimes 

three elements lens. This laser head allows you to cut or engrave materials such as rubber, wood, paper, 

leather, plastic, cardstock and many other. Thanks to full analog power modulation it is possible to engrave in 

shades of grey or change the output power during turns. The same effect can be achieved by using PWM 

signal which is fully compatible with PLH3D driver. High speed modulation (up to 100 kHz) allows to use high 

movement speed during engraving even complicated patterns. 

 

This module is using our brand new NUBM44 450nm diode (capable of 6W) which is the strongest available on 

market blue laser diode. Our recommended power supply units are 12V or 24V with current capacity at least 

1.5A (24V PSU), 2.5A (12V PSU). 

 

The lifetime of laser diode given by manufacturer is 10000 hours. There also an optional additional aluminum 

holder which allows easy mounting of the engraving laser head onto your gantry of choice that can be 

purchased. 
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Included Parts  

PLH3D-6W-XF Engraving Laser Head 

 

PLH3D-6W LaserDock Docking Station 

 

PLH3D Series Adapter for X-Carve Machine 

 

PLH3D-6W Nozzle - 43mm Spindle Adapter 

 

450nm Laser Safety Goggles 

 

PLH3D Lens Regulator 
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X-Carve Mount for PLH3D-Series 

 

Collimator 400-700nm 

 

12V 3.5A power supply. Includes adapters for wall plugs. 
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Basic Safety 

Only person with specialized training and appropriate laser safety knowledge can 

use and maintain the laser head. The laser head operator must be aware of laser 

radiation hazard. 

While laser head is operating protection Laser Glasses designed for 190 – 540 nm 

(OD 7+) should be used. Make sure that all personnel in the same room worn 

protection glasses. 

Eye exposure to the direct or diffusely reflected laser beam is a hazard. The laser 

head beam may cause permanent eye damage. 

Skin exposure to the laser beam is a hazard. The laser beam may cause serious 

skin burns. Laser beam may easily burn cloth. 

It is possible to get serious injury while using this product or being in the vicinity of 

an individual using it. Improper use of the laser head can result in injury or death.   

Flammable substances exposure to the laser beam may pose fire hazard. The laser 

head operation in an explosive atmosphere may be dangerous. The working area 

must be well ventilated. During the operation laser beam may ignite gases or 

flammable liquids. 

Be aware of poisonous and deadly gases which are released while engraving or 

cutting some synthetic materials. Precautions must be taken. 

Do not engrave or cut any kind of material that contains vinyl, or material with a 

similar chemical composition. Such material is corrosive and deadly dangerous.  

Before making any adjustments, changing accessories or performing 

maintenance, the laser should be powered off and disconnected from the power 

supply and CNC main board. 

The laser head must be properly mounted to a rigid body such that it cannot be 

moved unintentionally.  Unintentional move of the laser head is dangerous.  

The unauthorized personnel must have no access to the system into which the laser 

head is integrated. The laser head must be stored out of the reach of children. 

Untrained persons are not allowed to operate, maintain and observe operation of 

the laser head.  

Specular reflection materials should not be placed in front of operating lasers 

head. Remember, diffused reflection of the laser beam is uncontrolled and may 

pose hazard to eye. 

Appropriate shielding should be used around the system into which the laser head 

is integrated.  The system in which laser head is used must be equipped with key 

switch and safety interlock. 
 

Responsibility of use or misuse belongs to the end user.  Tomorrow’s System and its affiliates accept no 

responsibility for use or misuse by the user.  If you may not be able to use this product properly, we 

recommend that you do not begin use or cease use immediately.      
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Technical data 

 

 

 

 

 

 

 

 

 

 
 

 

 

 

1Since the working distance and lens choice can both have a slight effect on the amount of power from the laser head, it is difficult to 

specify an exact power value. 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

“Laser Off” state is <2 V. “Laser On” state is 3 – 24V.  
2 To use a PSU with voltage outside of this range, see the available accessories on our website.  

We also offer a 12V power supply. 

Optical Specifications, PLH3D-Series1 
High-Resolution 

Lens2 

High-Efficiency 

Lens3 

Recommended Working Distance4 20 – 120 mm 25 – 80 mm 

Beam Spot Width 0.1 mm 0.15 mm 

Beam Spot Height 0.1 – 0.5 mm 0.2 – 0.6 mm 

Example Focused Beam Spot Size,  

d = 80 mm (3.2”) 

0.1 x 0.3 mm 

(0.004” x 0.012”) 

0.15 x 0.6 mm 

(0.006” x 0.024”) 

Example Focused Beam Spot Size,  

d = 50 mm (2”) 

0.1 x 0.2 mm 

(0.004” x 0.008”) 

0.15 x 0.5 mm 

(0.006” x 0.020”) 

 
1 Specifications customizable for OEM customers on request. 
2 The High-Resolution Lens is a triplet (three-element) lens, f = 8 mm. This lens is recommended for applications requiring a more circular 

beam spot, higher power density or medium to long working distance.  
3 The High Efficiency Lens is an aspheric lens, f = 4 mm. This lens is recommended for applications requiring a higher power when it is 

practical to use a shorter working distance.  
4 Working distance is adjustable. The focused beam spot size depends on focal distance; shorter focal distance results in a smaller focused 

beam spot size  

Basic Specifications PLH3D-6W-XF 

Laser Diode Optical Power1 6 W 

Dimensions of Laser Head  

(L x W x H) 

40 x 55 x 78 mm 

(1.6 x 1.7 x 3.1 in.) 

Weight of Laser Head, Typ. 210 g (7.4 oz.) 

Flow Rate of Fan 43 m3/h (25 CFM) 

Fan Noise 58 dBA 

Mounting Hole Pattern 
4 Holes, 24 x 15 mm 

(0.94 x 0.59 in.) 

Mounting Hole Type M3 x 0.5 x 4.5 mm 

Ambient Temperature Range 

(Operating) 

0°C to 45°C 

(32 °F to 113°F) 

Electrical Specifications PLH3D-6W-XF 

Modulation Input 1 
Analog/TTL/PWM, 

0 – 5 V 

Modulation Input 21 TTL/PWM 0 – 24 V 

Recommended PWM Base Frequency 5 – 10 kHz 

Max. Modulation Bandwidth 30 kHz 

Input Impedance of Mod. In. 1 and 2 >1 k-Ω 

Power Supply Unit Voltage2 12 – 24 V 

12 V PSU Min. Current 2.5 A 

24 V PSU Min. Current 1.25 A 

Cable Length, Typ. 14 cm (5.5 in.) 

Wire Area (Gauge) 0.34 mm2 (22 AWG) 

Max. Power Consumption 30 W 
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2. Setup Hardware 

To mount the PLH3D-6W Series laser head, following tools are required: 

1. Small flathead screwdriver 
2. Hex Key H2.5  
3. Hex Key H3 

Note: Items will arrive wrapped in packaging material used to protect the hardware is transit during shipping. 

Be careful when removing/unwrapping the components from their packaging. It’s advised not to use a box 

blade or razor blade to unwrap or open the packaging to minimize the risk of nicking or cutting a cable. 

Mounting Setup 

1. Install Opt Lasers PLH3D-6W Series X-Carve Mounting Plate onto the X-Carve Spindle Holder. 

  

There are two primary ways to install the Mounting Plate to the Spindle Holder, and one less conventional way 

that is compatible with the Inventables X-Carve Dust Collection System. 

 

Mounting Option 1 (recommended) Mounting Option 2 Mounting Option 3 

Mounting Plate installed on to the Accessory 

mount of the Spindle Holder. This is the most 

common way to mount the laser module. 

Mounting Plate installed on to the clamping 

side of the Spindle Holder. 

This option is compatible with the Inventables X-

Carve Dust Collection System.  

3D print this X-Carve Laser Mount for Opt Lasers 

PLH3D 6W Laser, 

   

2. Install Docking Station  

Install Docking Station into Mounting Plate / Holder and Laser Module if you have it. Install the Docking 

station base onto the Mounting Plate / Holder. 

https://www.inventables.com/technologies/x-carve-dust-control-system
https://www.inventables.com/technologies/x-carve-dust-control-system
https://www.thingiverse.com/thing:2268197
https://www.thingiverse.com/thing:2268197
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Install Docking Station onto Laser Module. Be sure to check screws length when installing. 

 

  
 

3. Test Mounting 

The docking station should snap into place with the magnets. 
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Wiring Setup 

1. Unpackage the Opt Lasers PLH3D Series Adapter, cut the zip ties. 

 

 
2. Connect the 2 core wire Adapter inputs to the spindle outputs on your X-Controller. 

○ Connect the Brown wire to "Spindle (PWM)". 

○ Connect the White wire to "GND". 

 
3. Open the cable drag chain on the X-Carve. 

○ Use a small flathead screwdriver to open the cable chain. 
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4. Feed the 5-core wire from the Adapter through the entire drag chain. Feed the wire all the way to the 

Mounting Plate / Holder on the spindle mount. 

○ Make sure that there is enough wire when the Z-Axis is lowered all the way. 

 
5. Close the cable drag chain on the X-Carve. 

6. Insure that the pinout for the Docking Station connector is correct on the 

○ Laser Module 

○ Adapter Mounting Plate (on spindle mount) 

NOTE: The pinout for the Adapter Mounting Plate / Holder Docking Station should mirror the 

Laser Modules pinout. 

 
7. Attach the laser module to the spindle mount. 
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8. Put on your safety glasses and ensure nothing unintended is in the path of your laser. 

9. Ensure that the Adapter is Off. Connect Power Supply to the Adapter. 

 
10. Turn on your Adapter, the switch should glow red, and the fans on the laser module should spin-up. 

 
11. Done, ready to engrave. 

NOTE: The laser should NOT produce a beam / spot at this time.  

We have to send the laser a signal to fire. This is done in the following section. 
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3. Setup Software 

This section of the guide will show you how to backup your GRBL Settings, update your GRBL Firmware, and 

make some GRBL Settings changes. This guide will use Inventables Easel to do all of this. However, there are 

alternatives. Insure the Easel Drivers are Installed, and your machine is connected to your USB port. 

Test Fire the Laser 
Be sure to have your Laser Safety Glasses / Goggles on for this step, or whenever you have your laser powered. 

A. Goto and Sign into: Easel ( http://easel.inventables.com ) 

■ You might have to create an account if you have not yet. 

B. In a new or existing Project, 

■ Goto: Easel > Machine > Advanced 

 
C. Click on "Machine Inspector" 

 
D. In Machine Inspector 

■ Fire the Laser. 

Be sure everyone in the area has Laser Safety Glasses / Goggles on for this step! 

1. Scroll to "Console". 

2. Paste: "$32=0", and press enter. Insure that Laser Mode is Disabled. 

3. Paste: "M3 S1", and press enter. THIS WILL FIRE THE LASER 

a. Laser should fire at its lowest power, if it is powered (fan spinning) 

4. Paste: "M5", and press enter.  

a. This will stop firing the laser. 

■ Confirm / Note PWM Min & Max Settings, and that Laser Mode is disabled. 

1. Scroll to "Settings" and take note of the values of each setting. 

2. The settings should be something similar to this. This is just an example 

Setting Description 

$30=12000 Maximum spindle speed / RPM 

$31=0 Minimum spindle speed / RPM 

$32=0 Laser-mode enable, Boolean 

3. NOTE: Insure that Laser Mode is disabled "$32=0". 

a. Disable Laser Mode by pasting "$32=0" into Console and pressing enter. 

b. While Laser Mode is enabled ($32=1), your laser will not fire unless it is 

moving. Laser Mode alters the output based on the feed rate. 

4. NOTE: With the above settings (Laser Min / Max) = (Spindle "M3 S" 0 / 12000) 

https://github.com/gnea/grbl/wiki/Grbl-v1.1-Configuration
https://www.inventables.com/technologies/easel
https://github.com/gnea/grbl/wiki/Flashing-Grbl-to-an-Arduino
https://github.com/gnea/grbl/wiki/Flashing-Grbl-to-an-Arduino
http://easel.inventables.com/downloads
http://easel.inventables.com/
https://github.com/gnea/grbl/wiki/Grbl-v1.1-Laser-Mode
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These settings directly relate to and dictate the laser Min & Max output value. 

Firmware Settings: Make a Backup 
 Before we update the GRBL firmware it’s a good idea to backup your settings. 

A. Goto and Sign into: Easel ( http://easel.inventables.com ) 

B. In a new or existing Project, 

■ Goto: Easel > Machine > Advanced 

 
C. Click on "Machine Inspector" 

 
D. Copy all the text in the "Settings" section and save to a text file in-case you need to reference 

and restore settings. These setting are your GRBL Settings. 

■ Example Settings 
 Settings  Description 

$0=10 Step pulse time, microseconds 

$1=255 Step idle delay, milliseconds 

$2=0 Step pulse invert, mask 

$3=4 Step direction invert, mask 

$4=0 Invert step enable pin, Boolean 

$5=0 Invert limit pins, Boolean 

$6=0 Invert probe pin, Boolean 

$10=15 Status report options, mask 

$11=0.020 Junction deviation, millimeters 

$12=0.002 Arc tolerance, millimeters 

$13=0 Report in inches, Boolean 

$20=1 Soft limits enable, Boolean 

$21=1 Hard limits enable, Boolean 

$22=1 Homing cycle enable, Boolean 

$23=3 Homing direction invert, mask 

$24=25.000 Homing locate feed rate, mm/min 

$25=800.000 Homing search seek rate, mm/min 

$26=250 Homing switch debounce delay, milliseconds 

$27=1.000 Homing switch pull-off distance, millimeters 

$30=1000 Maximum spindle speed, RPM 

$31=0 Minimum spindle speed, RPM 

$32=0 Laser-mode enable, Boolean 

$100=40.000 X-axis travel resolution, step/mm 

$101=40.000 Y-axis travel resolution, step/mm 

$102=188.976 Z-axis travel resolution, step/mm 

$110=8000.000 X-axis maximum rate, mm/min 

$111=8000.000 Y-axis maximum rate, mm/min 

$112=500.000 Z-axis maximum rate, mm/min 

$120=250.000 X-axis acceleration, mm/sec^2 

$121=250.000 Y-axis acceleration, mm/sec^2 

$122=25.000 Z-axis acceleration, mm/sec^2 

$130=770.000 X-axis maximum travel, millimeters 

$131=780.000 Y-axis maximum travel, millimeters 

$132=94.000 Z-axis maximum travel, millimeters 

http://easel.inventables.com/
https://github.com/gnea/grbl/wiki/Grbl-v1.1-Configuration
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Firmware Update 
 There are a few ways to update the firmware on your X-Controller / GRBL Shield. 

 See the Advanced Users >: GRBL Firmware Update section for more information on other methods. 

A. Goto and Sign into: Easel ( http://easel.inventables.com ) 

B. In a new or existing Project,  

■ Goto: Easel > Machine > Advanced 

 
C. Backup Settings 

■ In Machine Inspector 

1. Scroll down to "Settings" 

2. Copy all the contents to a text file and save in-case you need it. 

D. Update Firmware 

■ Click on "Upload Firmware" 

 
■ NOTE: If you are not able to click the Upload Firmware option, make sure that: 

1. Easel Drivers are Installed 

2. Make sure your machine is connected to your USB port. 

3. Stop any programs that also are automatically using serial ports, like MakerWare. 

4. If you have Easel open in any other browser tabs or windows, try closing them 

■ Firmware version should be 1.1f or higher. 

 
E. After any Firmware Update, check that you check that your machine is working properly. 

Firmware updates can change settings. In the following section of this guide we will cover 

"Check your Current Settings". 

■ If you are still having issues getting your machine to behave as expected, go through the 

X-Carve Machine Setup. 

  

http://easel.inventables.com/
http://easel.inventables.com/downloads
http://easel.inventables.com/setup
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Firmware Configuration 
 Lastly some settings need to be confirmed / changed to make sure GRBL will output the correct power. 

A. Go to and Sign into: Easel ( http://easel.inventables.com ) 

B. In a new or existing Project,  

■ Go to: Easel > Machine > Advanced 

 
C. Click on "Machine Inspector" 

 
D. In Machine Inspector 

■ Check your Current Settings. 

1. Scroll down to "Settings" 

2. Check your current settings against any 

backups of your settings you might have. 

3. If you have settings you need / want to 

change, paste them into the console. If 

accepted, you will get an "ok" in reply. 

4. If you are still having issues getting your 

machine to behave as expected, go through 

the X-Carve Machine Setup. 

■ Configure / Note PWM Min & Max 

1. Scroll down to "Console" 

2. Paste in the following settings one at a time. 

Press Enter after each entry. You should get 

an "ok" in response after each entry. 

 

 

 

3. NOTE: While Laser Mode is enabled 

($32=1), your laser will not fire unless it is 

moving. This because laser mode alters the 

output based on the feed rate. 

4. NOTE: If your Router / Spindle is controlled 

by GRBL PWM, then disable laser mode 

before you carve / mill anything. Laser Mode 

can be disabled with "$32=0", and enabled 

with "$32=1". (Some users might need to set: 

$30=12000) 

Setting Description 

$30=1000 Maximum spindle speed / RPM 

$31=0 Minimum spindle speed / RPM 

$32=1 Laser-mode enable, Boolean 

http://easel.inventables.com/
http://easel.inventables.com/setup
https://github.com/gnea/grbl/wiki/Grbl-v1.1-Laser-Mode


16 
 

 

 
 

4. LightBurn: Setup and Configuration 

Copyright (c) 2018, LightBurn Software, LLC 

● LightBurn Documentation (GitHub) 

● LightBurn Video Tutorials 

 

LightBurn is the recommended software for laser engraving.  

There are other options if you decide not to use LightBurn.  

You are not limit to just this software for generating your G-Code and sending it to your CNC Machine. 

See the Advanced Users section of this manual once you are confident and feeling adventurous.  

Device Setup 

1. Download LightBurn. 

2. Install LightBurn. 

○ Windows may ask if you trust the software, as LightBurn is not currently digitally signed. 

3. Launch LightBurn. 

○ macOS may require that you:  

■ Go to > System Preferences > Security and Privacy > General.  

■ Click "Open Anyway". 

 

https://lightburnsoftware.com/
https://github.com/LightBurnSoftware/Documentation/blob/master/Copyrights.md
https://lightburnsoftware.com/pages/lightburn-documentation
https://github.com/LightBurnSoftware/Documentation/blob/master/README.md
https://lightburnsoftware.com/pages/tutorials
https://github.com/gnea/grbl/wiki/Using-Grbl
https://lightburnsoftware.com/pages/trial-version-try-before-you-buy
https://github.com/LightBurnSoftware/Documentation/blob/master/Installation.md
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■ Click "Open". 

 

4. Device Setup 

The first time that you launch LightBurn you will be promoted to setup your device (laser 

engraver). See LightBurns documentation for additional information. 

○ Select "GRBL". 

  
○ Select "Serial/USB". 

○ Input the name of your device 

■ Example: "X-Carve (GRBL)". 

○ Input the X-Axis Length, and Y-Axis Length. 

 
■ This is the max travel in the X axis and Y axis. 

● You Can look up your X-Carves max travel here at Inventables Support. 

○ 1000mm X-Carve: [ X-Axis = 770mm ], [ Y-Axis = 780mm ]  

○   750mm X-Carve: [ X-Axis = 550mm ], [ Y-Axis = 550mm ] 

○   500mm X-Carve: [ X-Axis = 300mm ], [ Y-Axis = 300mm ] 

● Also, Reference your GRBL settings by sending "$$" to view your max travel. 

○ The example below is for the 1000mm X-Carve 

○ $130=770.000  (X-axis maximum travel, millimeters) 

$131=780.000  (Y-axis maximum travel, millimeters) 

○ Set the Zero Point to Front Left. 

  
○ Review settings and Click Finished. 

https://github.com/LightBurnSoftware/Documentation/blob/master/DeviceWizard.md
https://inventables.desk.com/customer/en/portal/articles/2048690-what-is-the-maximum-size-material-that-can-be-carved-?b_id=9563
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○ Make your new device the default and click OK. 

  

5. Additional Device Settings  

The bellow settings are here to get you the maximum performance out of your Opt Laser. 

 Depending on whether or not you updated your GRBL firmware and GRBL settings 

○ GRBL v1.1f, v0.9c and newer 

■ LightBurn > Edit > Device Settings 

● G-Value Max: 1000 (GRBL: $30=1000) 

● Enable Z-axis 

● Relative Z moves only 

● Fast Whitespace Scan: 8000 mm/min 

● Enable Laser Fire Button 

  
 

○ GRBL v0.9j and older, if GRBL setting "$30" (Maximum spindle speed / RPM) can't be altered. 

■ G-Value Max 

GRBL v0.9j and older does not have the ability to change the set Spindle PWM range.  

There are also some cases, like when your spindle is controlled by this value, and need 

to be set in software. 

Because of this we will have to change a setting in LightBurn. 

■ LightBurn > Edit > Device Settings 

● G-Value Max: 12000 

● Enable Z-axis 

● Fast Whitespace Scan: 8000 mm/min 

● Enable Laser Fire Button 
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5. Usage and Operation: Software and Hardware 

To perform an engraving/cutting you will need to generate the G-Code that your machine will use to perform its 

operations. In this guide the G-Code will be generated with the Opt Lasers G-Code Generator, then sent to the 

X-Carve with CNCjs. Before we dive to deep we need to cover some basics. 

Basic Safety Guidelines 

● Always wear eye protection when laser is powered. 

● Fumes can also be harmful… wear an activated carbon mask &/or have proper ventilation. 

Basic Operation Guidelines 

● The less light absorbent a material is the more power / time it will take to cut / engrave. 

○ This means increasing the power output of the laser or decreasing the feed rate. 

● Putting too much power / heat into a material will lead to warping. 

○ If material starts to burn / warp / melt, try increasing the feed rate and perform multiple passes. 

● Some materials just can't be cut with light, try adding / coating that material is something light 

absorbent to make it easier to cut / engrave. 

Common Cutting Parameters 

Use these setting to help determine settings to use when cutting, can also help when engraving. 

Note, that these parameters can differ between materials, cooling temperature of laser module, focus distance, 

and other variables. It's often best to test and document your own settings on your materials. 

There are a lot of factors that can impact cutting and engraving settings. Uses these setting as a general 

starting point and work to fine tune settings that best fit your material. Always be aware that the more light-

absorbent your material is / can be, the easier it is to engrave, and vice versa. 

Material Thickness Focus Feed Rate Passes Z-Axis Steps Power 

Balsa Wood 5mm 60mm/s 1800mm/min 5 Zero 6W 

Fiber-reinforced foil (green) 0.1mm 60mm/s 3000mm/min 1 Zero 6W 

Rubber 0.5mm 60mm/s 900mm/min 3 0.25mm 6W 

Cardboard 0.5mm 60mm/s 480mm/min 1 Zero 6W 

3-layer cardboard 1.4mm 60mm/s 1200mm/min 3 0.5mm 6W 

5-layer cardboard 5mm 60mm/s 600mm/min 4 1.25mm 6W 

Polyfoam 15mm 60mm/s 480mm/min 2 10mm 6W 

Polyfoam 24mm 60mm/s 300mm/min 2 10mm 6W 

Leather 1.7mm 60mm/s 300mm/min 2 1mm 6W 

Jeans 0.5mm 60mm/s 480mm/min 1 1mm 6W 

Green Plexiglass 3mm 60mm/s 120mm/min 6 0.75mm 2W 

Red Plexiglass 3mm 60mm/s 120mm/min 4 0.75mm 6W 

  

http://rzmask.com/
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6. LightBurn: Basic Usage 

To get started with LightBurn there are some basic concepts to cover. All of these concepts are summarized 

from the LightBurn Documentation. 

Laser Operations 

LightBurn has the ability to perform multiple type of Laser Operations. 

These operations can be performed on vector and raster images / shapes. 

• Cut 

Cut will trace the laser along the vector path. Depending on the power and feed rate settings, this can 

be used to cut through a material in single or multiple passes. Decreasing the power and/or increasing 

the speed can also allow you to simply mark the surface (engraving). 

• Scan 

Scan will fill the interior of a vector similar to engraving a raster image.  

• Scan+Cut 
Combines the scan and cut operations. In order of operations, the scan will happen first, followed by 

the cut. This can be used to cut out a part once the scan is complete or simply emphasize the outline of 

the part before moving on to the next operation. 

Image Types 

There are two primary image types that you can work with Vector 

and Raster. These image types present different ways of engraving, 

each with their own benefits. Choose / Create your design and 

export it as a DFX, or BMP/JPG. 

Vector Engraving 

Vector shapes can be created directly in LightBurn without the need to import. 

 

See the LightBurn documentation for more details: 

● Creating Vectors in LightBurn 

● Importing External Vectors 

Raster Engraving 

Raster engraving is best for images will a lot of detail. 

Raster images have to be scanned onto the workpiece, the laser intensity dictates the depth or 

darkness of the image being output. The technique is similar to how an image scanner scans a paper 

into the computer. Reference the Common Cutting Parameters for a good starting place for some 

common materials. Its best to import high resolution images 300 dpi or higher. 

 

See the LightBurn documentation for more details: 

● Engraving Raster Images 

Image from: http://billspots.com/cnc-laser-cutting-engraving-basics 

https://github.com/LightBurnSoftware/Documentation
https://github.com/LightBurnSoftware/Documentation/blob/master/Operations.md
https://github.com/LightBurnSoftware/Documentation/blob/master/CreatingNewVectors.md
https://github.com/LightBurnSoftware/Documentation/blob/master/ImportingExternalVectors.md
https://github.com/LightBurnSoftware/Documentation/blob/master/EngravingImages.md
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Preform Engraving 

To get started we will create some vectors to test with by using the Rectangle and Ellipse Tools   

These are just some simple shapes the that we can apply Layers and Laser Operations too. 

Prepare Design 

1. We will start with some basic shapes. 

 
2. Select different Layers from the bottom layers bar, and apply a different layer to each vector. 

 
3. As different layers are applied you will see the applied layers in the "Cuts" Laser Operations widget. 

We will leave these cuts at their default settings.  

However, we could reference the Common Cutting Parameters for good starting values. 

 
4. The resulting vectors will look something like this. 

   
  

https://github.com/LightBurnSoftware/Documentation/blob/master/Layers.md
https://github.com/LightBurnSoftware/Documentation/blob/master/Operations.md
https://github.com/LightBurnSoftware/Documentation/blob/master/Layers.md
https://github.com/LightBurnSoftware/Documentation/blob/master/Operations.md
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Prepare Laser 

5. Connect to you Motion Controller / X-Controller / GRBL Shield. 

a. Next to devices select the appropriate port. 

b. Insure that the correct device, shown here as "X-Carve (GRBL)", is selected. 

 

6. Home your machine by clicking the  button. Tool-head / Laser will move to its home position. 

7. Select the Move widget. (this button can usually be found at the bottom of the Cuts widget) 

 
8. Move your toolhead / laser to it work position, where you would like to engrave. 

 
a. Jog machine into position with the arrow buttons, adjusting the distance and speed as needed. 

b. These buttons will allow you to jog the X-axis, Y-axis, Z-axis, and A-axis (if one is present). 

 
c. Set Laser Height to 60mm above work area. 
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9. Create Custom Marco's. 

We have to use some custom macros, because of reasons, as documented. 

How to create custom macro(s) 

1. Select the Console widget. 

2.  
3. Right-click / Two-finger-click on any of the Macro buttons to create a macro. 

4.  
5. Input the title of the macro, and the content of the macro 

6.  
Create a custom macro for each of the following. 

a. Zero Work Position 

■ G54 

■ G10 L20 P1 X0 Y0 Z0 

b. Goto Work Position (X/Y) 

■ G54 

■ G0 X0 Y0 

c. Goto Work Position (Z) 

■ G54 

■ G0 Z0 

d. Enable Laser Mode 

■ $32=1 

e. Disable Laser Mode 

■ $32=0 

10. Press "Zero Work Position" macro you created to set the starting position. 

a. Your laser should be in position from the prior, prepare laser steps. 

b. This will set the origin for where your laser will start engraving. 

11. Press "Enable Laser Mode" 

a. This will enable laser mode to give you better cutting results. 

b. ALWAYS remember to disable laser mode before using the router to cut if your router speed is 

controlled by the motion controller. 

  

https://lightburn.fider.io/ideas/248/user-origin-and-set-user-origin-based-on-work-position-s
https://github.com/LightBurnSoftware/Documentation/blob/master/CommonGrblSetups.md
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Engrave with Laser 

12. Power the laser module. 

a. Insure that all persons viewing have the proper eye protection / safety goggles. 

b. Turn on your Adapter, the switch should glow red, and the fans on the laser module should spin-

up. 

1.  
13. Start Engraving 

a. In the "Laser" widget, 

1. Insure that "Start From:" is set to "Absolute Coords". 

2. Trace / Frame the engraving on the work area before you engrave. 

1. Click  

2. This will move the tool head, outlining where it will be engraving in. 

3. When ready, press  to start engraving. 

b.  
14. Laser will begin engraving. 
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Advanced Users 
This section is not for beginners, the intent of this section is to provide additional 
information for advanced users. 

 

THE DOCUMENTATION IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR 
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR 
A PARTICULAR PURPOSE AND NON-INFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR 
COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN 
ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH 
THE DOCUMENTATION OR THE USE OR OTHER DEALINGS IN THE DOCUMENTATION. 
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7. GRBL Firmware Update (Needed for LaserMode) 

GRBL is firmware the runs on many CNC machine motion controllers, like the X-Controller for the X-Carve. 

GRBL interprets the G-Code you send to it into the motion / actions that your machine performs. 

In-order to get the latest features of GRBL, like LaserMode, the latest version needs to be flashed. Not all CNC 

machines use GRBL.The X-Carve and Shapeoko do however. Below is the process on how to update the 

GRBL firmware on your device. 

 

Preparation 

○ Download and install the Arduino IDE. 

■ https://www.arduino.cc/en/Main/Software  

Backup/Export 

Before you update your firmware, it's recommended that you backup / export your settings. This can be 

done by sending GRBL the command "$$", the view grbl settings command. 

NOTE: you can export your settings using Arduino IDE or Easel 

○ Connect your computer to your motion controller, X-Controller, or GRBL Shield. 

Arduino  

■ Check Board 

● Arduino IDE: Tools > Board: "Arduino/Genuino Uno". 

■ Check Port 

● Arduino IDE: Tools > Port: "COMX (Arduino/Genuino Uno)". 

■ Open Serial Monitor 

● Arduino IDE: Tools > Serial Monitor. 

● Set Baud Rate 

○ Change to "115200 baud", located at bottom of Serial Monitor 

● Set Line Ending 

○ Change to "Both NL and CR", located at bottom of Serial Monitor 

● Export Settings 

○ Input and Send "$$". 

○ Copy and Paste all the output in to a text file and save it. These are your settings, 

you might need them later to restore from. 

Easel 

○ Insure that the Easel Driver is installed. 

○ Go to: Machine > Advanced > Machine Inspector. 

https://github.com/gnea/grbl
https://github.com/gnea/grbl/wiki/Grbl-v1.1-Laser-Mode
https://www.arduino.cc/en/Main/Software
https://github.com/gnea/grbl/wiki/Grbl-v1.1-Configuration#---view-grbl-settings
https://github.com/gnea/grbl/wiki/Grbl-v1.1-Configuration#grbl-settings
http://easel.inventables.com/downloads
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○ Export Settings 

■ Once connected you can scroll to the bottom. Copy and Paste all the output in to a text 

file and save it. These are your settings, you might need them later to restore from. 

Flashing 

○ Option 1: Flash pre-built GRBL binary. 

■ Download the latest GRBL compiled binary release 

● Example: "grbl_v1.1f.20170801.hex" 

■ Follow the instructions found in GNEA GRBL Wiki: Flashing Grbl to an Arduino. 

● Windows: use X-Loader to flash the binary. 

● Mac: use HexUploader to flash the binary. 

○ Option 2: Compile and Flash GRBL with Arduino IDE. 

■ Follow the instructions on the GNEA GRBL Wiki: Compiling Grbl 

● Download the latest GRBL source release, "Source code (zip)",  this contains the 

GRBL library. 

● Extract the grbl-x.x.YYYYMMDD.zip 

● Open and edit the "config.h" file found the extracted subfolder "grbl". 

● Make the suggested changes to "config.h" noted in X-Carve GRBL-1.1f Settings 

gits. 

● Move subfolder "grbl" to the Arduino IDE library folder. 

● Open the Arduino Example "GrblUpload". 

○ Arduino IDE: File > Examples > grbl  

■ Can be found under Custom Libraries (at the bottom) 

● Flash the firmware. 

○ Arduino IDE: Sketch > Upload. 

○ After updating the firmware check to make sure that everything is still working. 

2. Configuration 

○ Set GRBL Spindle RPM / Laser Output Range by sending GRBL the commands: 

$30=1000 Max spindle speed, RPM 

$31=0  Min spindle speed, RPM 

  

https://github.com/gnea/grbl/releases
https://github.com/gnea/grbl/wiki/Flashing-Grbl-to-an-Arduino
http://xloader.russemotto.com/XLoader.zip
https://github.com/paulkaplan/HexUploader/wiki/Using-HexUploader
https://github.com/gnea/grbl/wiki/Compiling-Grbl
https://github.com/gnea/grbl/releases
https://gist.github.com/AustinSaintAubin/5fb4343cc34f94578d62b1432178632b
https://www.arduino.cc/en/Hacking/Libraries
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8. CNCjs 

CNCjs is a full-featured web-based interface for CNC controllers running Grbl, Marlin, Smoothieware, or TinyG. 

For a more complete introduction, see the Introduction section of the CNCjs wiki page. 

 

Software Setup 

1. Download the latest CNCjs release for your operating system. 

○ Win x64: cncjs-app-1.9.15-win-x64.exe 

○ macOS: cncjs-app-1.9.15-mac-x64.dmg 

○ … and many more. 

2. Install CNCjs by double clicking on the downloaded installer. 

Software Usage 

1. Launch CNCjs from your Start Menu / Application Dock 

2. In the "Connection" widget. 

○ Select the "Port" that is your X-Controller, or similar. 

○ Set the "Baud rate" to 115200. 

○ Click "Open" 

3. The Console widget should output the current settings when 

you connect. If not send the command "$$". 

○ Make sure the GRBL Spindle RPM / Laser Output 

Range set correctly. 

 $30=1000 Max spindle speed, RPM 

 $31=0  Min spindle speed, RPM 

○ Enable GRBL Laser Mode (Optional) 

https://github.com/cncjs/cncjs
https://github.com/grbl/grbl
https://github.com/MarlinFirmware/Marlin
https://github.com/Smoothieware/Smoothieware
https://github.com/synthetos/TinyG
https://github.com/cncjs/cncjs/wiki/Introduction
https://github.com/cncjs/cncjs/releases/latest
https://github.com/cncjs/cncjs/releases/download/v1.9.15/cncjs-app-1.9.15-win-x64.exe
https://github.com/cncjs/cncjs/releases/download/v1.9.15/cncjs-app-1.9.15-mac-x64.dmg
https://github.com/gnea/grbl/wiki/Grbl-v1.1-Laser-Mode


30 
 

■ If you have the GRBL v1.1f installed on your motion controller, then you can optionally 

enable Laser Mode.  

● $32=1  Laser Mode ENABLED. 

● $32=0  Laser Mode DISABLED. 

○ Remember to disable Laser Mode when you decide to use router to cut. 

○ NOTE: If any of the setting are not correct, you can update them by sending the command as 

you would want it to appear. 

■ Example: $##=VALUE 

● ## is the setting number you want to change. 

● VALUE is the value it is / you want to update it to. 

4. Run Homing Cycle.  

○ Click the "Homing" button in the upper right,  

and allow the machine to home. 

5. Jog your laser into position using the "Axes" widget. 

○ Keyboard input can be enabled by clicking the keyboard 

icon at the top of the widget. 

6. Set Laser Height to 60mm above work area. 

○ Use a ruler and measure 60mm above from just below 

the head of the laser module to the work area. If you 

have adjusted you focus, move to your preferred focus 

depth. 

 

7. Zero each axis by clicking the  icon for each work position axis. 

○ This will set this position as the place where G-Code will be started from. 

○ Note that you can set multiple work positions. 

8. Insure that all persons viewing have the proper eye protection / safety goggles. 

9. Power the laser module. 

○ Turn on your Adapter, the switch should glow red, and the 

fans on the laser module should spin-up. 

 
10. Test that the laser is working by using the "Laser" widget. 

○ In the "Laser Test" section of the widget. 

■ Set power to ~1% 
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■ Set the test duration to ~500 ms. 

■ Click "Laser Test" at the bottom. 

○ The laser should fire for a brief moment. Hooray! 

11. Load G-Code 

○ You can drag and drop G-Code into the CNCjs window to load it. 

○ A preview of the g code should appear. 

 
12. Run G-Code 

○ Click the play button at the top to run the G - Code. 

 
13. NOTE: You can pause the job by pressing "Feedhold" at any time. Press "Cycle Start" to resume. 

  



32 
 

9. Opt Lasers Software Usage 

This section will explain step by step how to use and export the G- code generated with the Opt Lasers G-

Code Generator. Then how to import that G -code into Grbl-Panel and control your machine to run the 

engraving G -code. 

Opt Lasers G-Code Generator 

 
There are two primary image types that you can work with Vector and Raster. 

These image types present different ways of engraving, each with their own benefits. 

Choose / Create your design and export it as a DFX, or BMP/JPG. 

 

 

Getting Started with Opt Lasers G-Code Generator: 

1. Download and install Opt Lasers G-Code Generator. 

2. Select the DFX Tab, if you are engraving / cutting based on a vector as a DFX file. 

3. Select the BMP/JPG Tab, if you are engraving based of a raster image as a BMP/JPG file. 
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Vector: DFX 

DFX is a vector file type. 

Vector engraving / cutting is preferred when cutting or doing quick engravings. 

Vector engraving will generally follow the path of the engraving, as opposed to scanning over it. 

Reference the Common Cutting Parameters for a good starting place for some common materials 

1. Download and Install  

2. Open DFX file. 

3. Alter Settings > Parameters as needed.  

○ Idle Speed 

● Rapid movement feed rate used when laser is moving to an area to engrave/cut. 

● Set to a high feed rate, like 8000 mm/min or higher. 

● Lower this feed rate if movements create too much vibration. 

○ Work Speed 

● Slower movement feed rate used when laser is engraving/cutting. 

● Lowering this value can help get deeper cuts, darker engravings, smoother lines. 

○ Material Thickness 

● Used to determine passes needed when cutting through material. 

○ Curve Accuracy 

● Value determines steps in curve. Lower number = smoother curve 

● Leave at default. 

○ One-Pass Thickness. 

● Material cut per pass of the laser. 

● Setting this value to 1 for 5mm thick material will result in 6 passes, 1 pass on the top, 

and 5 additional passes, each lowering the z-axis by 1mm. This will cut all the way 

through the 5mm thick material 

○ Additional Last Cut 

● Adds one additional pass at the end. 

● This helps with ensuring a clean cut on material that might not be constant. 

○ Profile 

● Present for your material that you can save to and load from. 

● This can help you build "profiles" for known working settings. 

○ Start Point 

● The starting point of your work area. Change this dependent on where you want to zero 

your work area to. 

● Best to set this to the lower left corner. 

 
4. Click G-Code Tab. 

○ Generate G-code. 

○ Save G-code to file. 

● To be engraved with Grbl-Panel, or similar software 
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Raster: BMP/JPG 

BMPs and JPGs are raster-based file types. Raster engraving is best for images will a lot of detail.  

Raster images have to be scanned onto the workpiece, the laser intensity dictates the depth or darkness of the 

image being output. The technique is similar to how an image scanner scans a paper into the computer. 

Reference the Common Cutting Parameters for a good starting place for some common materials. 

1. Open BMP or JPG. 

2. Alter Settings > Parameters as needed. 

○ Idle Speed 

● Rapid movement feed rate used when laser is moving to an area to engrave/cut. 

● Set to a high feed rate, like 8000 mm/min or higher. 

● Lower this feed rate if movements create too much vibration. 

○ Work Speed 

● Slower movement feed rate used when laser is engraving/cutting. 

● Lowering this value can help get deeper cuts, darker engravings, smoother lines. 

○ Material Thickness 

● Used to determine passes needed when cutting through material. 

○ Pixel Size 

● Set the size of a pixel. Used to help scale the image. 

● Example: 1 pixel = 0.1 mm (10 pixels will fit in 1 mm scan line) 

○ X and Y Resolution. 

● Used to specify the source image resolution. 

○ Keep Aspect Ratio 

● Keeps the image proportional as you scale. 

○ Fit 

● Fits the image to the window display. Just used for previewing. 

3. Alter Image Settings as needed. 

○ Image Scanning 

● Horizontal and Vertical Raster 

■ The orientation of image scanning to use. 

● Grayscale 

■ Enabling Grayscale will generate an engraving that will include all values within 

the min and max power settings, giving you more… grayscale. 

■ Disabling Grayscale will cause the laser just to perform at its min and max power 

settings, ON/OFF, with no middle range. 

● Dithering 

■ Enabling Dithering will render the image as a Dithering Map. 

■ Dithering if useful if an image is not engraving deep enough. 

○ Power Control 

● Laser power to be applied to the workpiece limited by the Min and Max settings. 

○ Correction. 

● Basic image correction settings. 

4. Click Image settings Tab. 

○ Alter Image settings as needed. 

5. Click G-Code Tab. 

○ Generate G-code. 

○ Save G-code to file. [To be engraved with CNCjs, Easel, or similar software]  

 


